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WavesMon User's Guide 
 

1 Introduction 
The WavesMon software is real-time waves-data collecting and processing soft-
ware.  WavesMon can collect real-time data for a four beam upward looking 
ADCP (Workhorse) as well as a narrow three beam horizontal ADCP with 
Waves enabled.  WavesMon uses array processing and can distinguish waves 
from multiple directions at similar frequencies along with the current profiles. 

WavesMon applications include: 

• Coastal Protection and Engineering 
• Port Design and Operation 
• Environmental Monitoring 
• Oil industry (oil platforms, LNG terminals, etc.) 
• Shipping Safety  

 

NOTE.  This guide file covers WavesMon version 3.07. 
The latest versions of our software can be downloaded through our Customer 
Support section on our web site (http://www.rdinstruments.com/support/support.aspx).  
You must register before you are able to download. 

 

1.1 How to Contact Teledyne RD Instruments 
If you have technical issues or questions involving a specific application or dep-
loyment with your instrument, contact our Field Service group:  
Teledyne RD Instruments  Teledyne RD Instruments Europe 

14020 Stowe Drive 
Poway, California 92064 

 2A Les Nertieres 
5 Avenue Hector Pintus 
06610 La Gaude, France 

Phone +1 (858) 842-2600  Phone +33(0) 492-110-930 

FAX +1 (858) 842-2822  FAX +33(0) 492-110-931 

Sales – rdisales@teledyne.com  Sales – rdie@teledyne.com 

Field Service – rdifs@teledyne.com  Field Service – rdiefs@teledyne.com 

Client Services Administration – rdicsadmin@teledyne.com  
Web: http://www.rdinstruments.com 

24 Hour Emergency Support +1 (858) 842-2700 
 

http://www.rdinstruments.com/support/support.aspx�
mailto:rdisales@teledyne.com�
mailto:rdie@teledyne.com�
mailto:rdifs@teledyne.com�
mailto:rdiefs@teledyne.com�
mailto:rdicsadmin@teledyne.com�
http://www.rdinstruments.com/�
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1.2 Conventions Used in this Guide 
Conventions used in the WavesMon User’s Guide have been established to help 
you learn how to use these programs quickly and easily. 

Windows menu items are printed in bold: File menu, Import Mission.  Items 
that need to be typed by the user or keys to press will be shown as <F1>.  If a key 
combination were joined with a plus sign (<ALT+F>), you would press and hold 
the first key while you press the second key.  Words printed in italics include 
program names (BBTalk, PlanADCP) and file names (dpl1_6.dpl). 
Code or sample files are printed using a fixed font.  Here is an example: 
WorkHorse Broadband ADCP Version 51.XX 
TELEDYNE RD INSTRUMENTS (c) 1996-2010 
ALL RIGHTS RESERVED 
> 
 

You will find three other visual aids that help you: Notes, Cautions and Recom-
mended Settings. 

 

NOTE.  This paragraph format indicates additional information that may help to 
a void issues or things for considerations. 

 

 
CAUTION.  This paragraph format warns the reader of hazardous procedures 
(for example, activities that may cause loss of data or damage to the ADCP). 

 

 
Recommended Setting.  This paragraph format indicates additional 
information that may help you set command parameters. 

 

1.3 System Requirements 
The WavesMon software requires a Windows® compatible computer with the 
following specifications: 

• Windows XP® or Windows 2000®   
• Pentium III 400 MHz class PC (higher recommended) 
• 2GB of RAM  

 
CAUTION.  Using less computer memory can cause the system to reset. 

 

• 10 MB Free Disk Space plus space for data files (A large, fast hard disk 
is recommended) 

• One Serial Port (two or more High Speed UART Serial Ports are option-
al) 

• Minimum display resolution of 1024 x 768, 256 color (higher recom-
mended) 

• CD-ROM Drive 
• Mouse or other pointing device 
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1.4 WavesMon Requirements 
WavesMon can only process raw data from an ADCP that meets the following 
criteria: 

• The ADCP has to have the waves feature installed. 
• The ADCP need 16.28 firmware or later and the horizontal ADCP 300k 

Hz narrow-beam needs 11.07 firmware or later. 
• The ADCP has to have a pressure gauge installed. 
• For ADCP deployed as Self-Contained units, the system needs sufficient 

memory and batteries.  Use the PlanADCP software to plan wave-
deployments. 

1.5 Software Installation 
To install WavesMon, do the following. 

a. Insert the compact disc into your CD-ROM drive and then follow the brows-
er instructions on your screen.  If the browser does not appear, complete 
Steps “b” through “d.” 

b. Click the Start button, and then click Run. 

c. Type <drive>:launch.  For example, if your CD-ROM drive is drive D, type 
d:launch. 

d. Follow the browser instructions on your screen. 

2 Software Overview 
• WavesMon is a software package used to set up real-time applications as 

well as post processing data from a self-contained ADCP. 
• By default WavesMon does array processing on ADCP data, but it can al-

so do UVW processing by selecting Moored (Dynamic) Mounting. 
• WavesMon can also process waves-data from a 3-beam 10-inch 300k Hz 

horizontal ADCP. 
• WavesMon can process packet data as well as continuous profile data 

(ensembles data). 
• WavesMon will output data to several files (see WavesMon Output Data 

Formats).  It will output all the current-profile data to one file (*.PD0), 
all the wave-process data to one binary file (*.wvs) which can read by 
WavesView, several text output formats, PNG files, and to a binary file 
for DHI’s Mike0 modeling software. 

 
NOTE.  For step-by-step instructions on how to use WavesMon, see the 
Waves Quick Start Guide.   
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2.1 Create a Project File 
WavesMon is setup to collect or process data using the Project Wizard.  The 
Project Wizard gives the user the ability to setup the ADCP quickly by only 
entering the critical ADCP environment data and allowing the WavesMon pro-
gram to set the other parameters, or the user can select to use the Advanced 
Configuration options.  Once setup, the project can be saved and then later re-
trieved. 

The idea behind the projects is to keep track of how data is processed.  That 
means that once a project has been used to process data, it will be locked and 
cannot be changed.  To change processing parameters, duplicate the project, 
make the changes, and then re-process the data (see Reprocessing Raw ADCP 
Data and Editing Projects). 

2.1.1 Save Projects 
Use the Project Wizard to setup WavesMon for either Realtime data collection 
(see Collecting Real-Time Data with WavesMon) or Reprocessing data (see Re-
processing Raw ADCP Data).  Once the Project Wizard is completed, on the 
File menu, select Save Project.  Enter the File name and select Save.  Waves-
Mon will automatically add the file extension *.prj. 

 
Figure 1. Saving a Project File 

2.1.2 Open Projects 
To open a project file, on the File menu, select Open Project.  On the Select 
Project File dialog, select the project file and click Open. 

Projects can contain multiple data files.  To open a data file, use the File menu 
and select Open Project Data Files.  Select the data file to open and click 
Open. 

2.1.3 Project Management 
The “heart” of Waves is the project file (*.prj).  A project file is created by run-
ning the Project Wizard (see Collecting Real-Time Data with WavesMon) or 
Reprocessing data (see Reprocessing Raw ADCP Data).   
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To open the Project Management Window, on the View menu, select Project 
Management.  The Project Management Window gives the user a quick and 
easy way to manage the files.  It uses a tree structure; click the + box to expand 
the list or – to collapse.  Right clicking on a node will bring up menus to quickly 
access different functions. 

 
Figure 2. Project Management Window (Right-Click Menu) 

To review the settings on the wizard screens, use the Configure menu and select 
Properties.  Select either Playback Configuration or Real-time Configura-
tion.  This will allow you to review each screen setup during the wizard.  Click 
OK to exit the screen.   

Right-clicking on the Field or Playback Configuration node and selecting 
Properties will do the same thing as using the Configure menu. 

 

NOTE.  Stop data collection or playback before reviewing the 
configuration.  If an item needs to be changed, make a duplicate and then 
change it.  To change items, see Editing Projects. 
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2.2 Setting WavesMon’s Workspace 
A Workspace is a collection of windows arranged and sized, as you prefer.  To 
create a Workspace file, open all the windows you want to see during data col-
lection.  Open and arrange the views you are interested in.  When you have the 
displays set up the way you prefer, on the File menu, click Save Workspace.  
When the program is restarted, the default workspace is displayed.  To return to 
your workspace, use File, Load Workspace. 

2.2.1 Changing Units 
To change the units for all displays, on the Configure menu, select Units.  You 
can change units to All English, All SI or use the Advanced menu and select 
each unit for Velocity, Range/Depth, and Temperature. 

2.2.2 Changing the Coordinate System 
To change the coordinate system, on the Configure menu, select Coordinate 
System.  You can select Earth or Raw-Beam   

2.2.3 Changing Global Parameters 
To change the global parameters of the displays, select the Configure menu, and 
click Global Parameters.  This menu allows changes to the number of sections 
on the X and Y axes, the Grid Lines (visible, style, and color), and Background 
Color.   

To return to the factory defaults, check the Reset to Factory Defaults box and 
select Apply.  Click OK to exit the screen. 

 
Figure 3. Global Parameters 
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2.2.4 Toolbars 
Depending on what mode WavesMon is in (Data Collection, Playback, or ready 
mode), the toolbars will have different active buttons available. 

 Ready 

 Collecting Data 

 Playback Mode 
Figure 4. Toolbars 
 

Playback Controls – Use the Playback Controls to Stop, Pause, Start Play-
back, or Play Next Burst.  The Stop button is active in both data collection and 
playback modes. 

Go – A red Go button indicates WavesMon is waiting to start data collection.  

When clicked or in Playback mode, it is grayed out.  Use the Stop button to stop 
data collection. 

Zoom to Data – click the blue title bar at the top of the window to select the 
graph and then click the Zoom to Data button on the toolbar ( ).   

Zoom In – Click the Zoom In ( ) button on the toolbar.  The cursor will 
change to a “+” magnifying glass.  Hold down the left mouse button and drag 
over an area on the window to zoom in.  The chosen region will be zoomed to 
the full plot width. 

Zoom Out – Click the Zoom Out ( ) button on the toolbar.  The cursor will 
change to a “-” magnifying glass.  Hold down the left mouse button and drag 
over an area on the window to zoom out.   

 

NOTE.  The Time Series, Velocity Direction, Velocity Profile and 
Velocity Profile 2, and the Wave Height Spectra views can use the zoom 
functions. 

 

Pan – Use the Pan button on the toolbar ( ) to move the graph data as needed. 

Arrow Cursor – Click the Arrow Cursor button on the toolbar ( ) and use it 
to identify values on the plots. 

Show Wizard – Starts the New Project Wizard (see Collecting Real-Time Da-
ta with WavesMon or Reprocessing Raw ADCP Data) 

2.2.5 Available Graphs 
There are five main displays selected by default: the Directional Spectrum 
(Polar) view, Time Series view, the Velocity Direction view, the Velocity Pro-
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file, and the Wave Height Spectra view.  The Window menu allows you to 
quickly choose the views that you would like to see and remove the ones that 
are not of interest. 

There are three other displays that can be viewed – Velocity Profile 2, Horizon-
tal Velocity Profile, and Directional Spectrum (Cartesian). 

 
Figure 5. WavesMon Displays 

Velocity Profile Plot 
The profile view displays a current profile in the coordinate frame in which it is 
to be gathered by the ADCP, or it can convert the data to earth coordinates.  The 
default scale for this plot is set in the Configure menu; however there are tool 
bar buttons ( ) that allow you to change it on the fly.   

The dashed line indicates the location of the selected bin.  To change the se-
lected bin click the up/down ( ) toolbar buttons.  If the ADCP is configured 
for beam radial data, the magnitude and direction displays will be invalid.  
The selection of beam coordinates in the profile display is for trouble-shooting 
purposes only.  WavesMon can only convert from data gathered in other than 
earth coordinates to earth coordinates – it cannot convert data gathered in earth-
coordinates to the other coordinate frames (because we allow transformations to 
earth coordinates when one beam is marked bad and when the ADCP uses this 
capability the reverse transformation is poorly defined). 
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Figure 6. Velocity Profile Window 

To change how the Velocity Profile Window is configured right-click on the 
window and click Properties.  This screen allows changes to the Axis Values, 
Labels, Titles, Line Legend, and Colors.  Click OK to exit the screen. 

 
Figure 7. Configure Velocity Profile Window 
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To change the Bottom and Top X-Axis between East, North, Earth Up, and 
Earth Error, right-click on the Velocity Profile window and click Data Selec-
tion.  Click OK. 

 
Figure 8. Data Selection Dialog – Velocity Profile 

Directional Spectrum (Polar) 
The default scale is set to dynamic. Red is maximum and black is minimum.  If 
WavesMon is not able to process a directional spectra plot, WavesMon will leave 
the last good plot on the screen and a red dot in the lower right corner will indi-
cate that the plot is not from the last collected waves-burst. 

 
Figure 9. Directional Spectrum (Polar) Window 

To change how the Directional Spectrum window is configured right-click on 
the window and click Properties.   

This screen allows changes to the Axis Values, Labels, Titles, Line Legend, 
and Colors.  Click OK to exit the screen. 
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Figure 10. Configure Directional Spectrum (Polar) Window 

Time Series 
The Time Series window displays time series of significant wave height, peak 
period, peak direction, and water depth.  Data that is missing or bad is not 
shown.  To select a time in the series click the left mouse button over the data of 
interest.  

 
Figure 11. Time Series Window 

To change how the Time Series Window is configured right-click on the window 
and click Properties.  This screen allows changes to the Axis Values, Labels, 
Titles, Line Legend, and Colors.  Click OK to exit the screen. 

 
Figure 12. Configure Time Series Window 
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To change between Burst Number or Burst Start Time, right-click on the 
Time Series window and click Data Selection.  Click OK. 

 
Figure 13. Data Selection Dialog – Time Series 

Current Velocity Direction 
This view displays the current magnitude and direction with an analog line. The 
length of the line is scaled the same as the scale selected for the profile plot. 

 
Figure 14. Velocity Direction Windows 

To change how the Velocity Direction Window is configured right-click on the 
window and click Properties.  This screen allows changes to the Axis Values, 
Labels, Titles, Line Legend, and Colors.  Click OK to exit the screen. 

 
Figure 15. Configure Velocity Direction Window 
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To change from Earth, Ship, or XYZ Velocity Directions.  Right-click on the 
Velocity Direction window and click Data Selection. Click OK. 

 
Figure 16. Data Selection Dialog – Velocity Direction 
 

Wave Height Spectra 

The Wave Height Spectra view displays height spectra in units of [ ] as 
calculated from the pressure sensor, orbital velocities, and surface echo location. 

 
Figure 17. Wave Height Spectra Window 

To change how the Wave Height Spectra Window is configured right-click on 
the window and click Properties.  This screen allows changes to the Axis Val-
ues, Labels, Titles, Line Legend, and Colors.  Click OK to exit the screen. 

 

m
Hz
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Figure 18. Configure Wave Height Spectra Window 

Right-click on the Wave Height Spectra window and select Data Selection. You 
can change the X-Axis between Pressure, Surface, or Velocity Frequency.  
Individual plots on the Y-Axis may be turned on or off as desired.  Click OK. 

 
Figure 19. Data Selection Dialog – Wave Height Spectra 

Current Profile 2 Plot 
The Velocity Profile 2 window displays velocity magnitude and direction versus 
depth.  The default workspace has this window hidden behind the Velocity Pro-
file window.  Use the Window menu to bring the window to the front. 

 
Figure 20. Velocity Profile 2 Windows 

To change how the Velocity Profile 2 Window is configured right-click on the 
window and click Properties.  This screen allows changes to the Axis Values, 
Labels, Titles, Line Legend, and Colors.  Click OK to exit the screen. 
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Figure 21. Configure Velocity Profile 2 Window 

Horizontal Current Profile 
These plots are similar to the Velocity Profile window, but in a horizontal for-
mat (see Velocity Profile Plot).  Use the Window menu to view this plot.  

 
NOTE.  This plot is only for the 300k Hz 10 Inch 3 beam horizontal ADCP. 

 

 
Figure 22. Horizontal Current Profile 
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Directional Spectrum (Cartesian) 
These plots are similar to the Directional Spectrum (Polar) window, but in a 

Cartesian (see Directional Spectrum (Polar)).  The units are [ ]. 

If the user changed units to English, then the plot has the units of [ ]. 
Use the Window menu to view this plot. 

 
Figure 23. Directional Spectrum (Cartesian) 
 

2Meters
Hz cycle•

2Feet
Hz cycle•
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2.3 Collecting Real-Time Data with WavesMon 
a. Start WavesMon. 

b. On the File menu, click New Project.   
c. At the Select Input Type dialog, choose one of the following:  

• Real-time: Direct ADCP Connection – The ADCP is connected to the 
computer (see Figure 25). 

• Real-time: Polled Comm Port - The Polled Mode configures Waves-
Mon to listen to the COM port only.  

 
Figure 24. ADCP COM Port Setup 

Use Factory Defaults box – If this box is checked, the wizard screens will be 
set to the factory defaults. 
ADCP COM Port Setup  
If Real-time: Direct ADCP Connection was selected, click on the Auto Detect 
button and WavesMon will find the baud-rate of the connected ADCP or enter 
the settings manually.  Press the Connect button and then click Next and Wa-
vesMon will find a Workhorse or a Horizontal ADCP. 
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Figure 25. ADCP COM Port Setup 

The box next to the Modem Break Sequencing Label allows the user to confi-
gure WavesMon for varying “Break Timeouts”.  This setting will prevent Wa-
vesMon from “timing out” due to a slow telemetry link to the ADCP.  The 
command and break timeouts can be set larger than the defaults if someone is 
communicating through a slow telemetry link to the ADCP. 
Real-Time: Polled Comm Port 

The Polled Mode configures WavesMon to listen to a serial port. WavesMon 
will not configure or start the ADCP.  The assumption is the ADCP is already 
configured and is already sending data to the serial port WavesMon is listening 
to. 

d. Follow through the wizard screens by entering the needed information and 
than pressing Next to move to the next screen.  For details on how to set 
each page, see the following sections. 

• Deployment Info 
• Data Sampling  
• Data File Output  
• ADCP Environment  
• Advanced Processing 
• Data Screening 
• Processing and File Outputs 
• Advanced File Outputs 
• Graphical Outputs 
• ADCP Commands 
• Real-Time Data Collection Summary 

e. Review the summary. 

f. Click Finish.   
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g. Click the GO button on the WavesMon toolbar.   

 
Figure 26. Data Collection Toolbar 

h. If the results are not what you expected, click the Stop button on the toolbar.  
Select Configure, Properties and select Realtime Configuration.  Select 
the page you wish to change.  Enter your changes and click OK.  Save the 
project file if you make changes by selecting File, Save Project.  Start data 
collection again by clicking the Go button. 

2.3.1 Deployment Info 
WorkHorse ADCP deployed upward looking 

 
Figure 27. Deployment info – WorkHorse ADCP 

In this example, a 600kHz WorkHorse ADCP is deployed at 22m, the altitude of 
the ADCP is 0.5m, and the magnetic variation is 12.5 deg west (-12.5 deg).  The 
wizard will configure the ADCP to collect wave bursts in packets mode.  For 
more details about this, see ADCP Environment. 

 

NOTE.  The Depth is the estimated depth of water from the ADCP face to 
the surface.  The Altitude Above Bottom is the distance of the ADCP 
face from the seafloor. 

 
System Type and Altitude 

Select the ADCP’s System Frequency.  Select the System Type. 

Enter the ADCP Environment information.  The Depth is the estimated depth 
of water from the ADCP face to the surface.  The Altitude is the distance of the 
ADCP face from the seafloor.   
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Enter the Magnetic Variation to correct the data from magnetic north to true 
north.  East degrees shall be entered as positive value and west should be en-
tered as a negative value. 
Other Options 

If the Moored (Dynamic) Mounting checkbox is enabled, WavesMon will con-
figure the ADCP to collect heading, pitch and roll data for every packet ensem-
ble and do UVW rather than array processing for the wave parameters.  

 

NOTE.  Moored (dynamic) mounting: (When HD111100000 is set). 
WavesMon requires at least one current profile in the waves-burst in order 
to apply the Magnetic Variation to the wave process data. 

 

300k Hz Narrow-beam horizontal ADCP 

 
Figure 28. Deployment info – Horizontal ADCP 

In this example, a 300kHz H-ADCP is deployed at 20m, the altitude of the 
H-ADCP is 12m and the magnetic variation is 12.5 deg west (-12.5 deg).  Wa-
vesMon will configure the Horizontal ADCP in ensemble mode, as Horizontal 
ADCPs do not support packets mode at this time. 

When Horizontal ADCP is selected for the System Type, enter the Spectral 
Range Cells in the Range Cells Used For Waves box. 

 

NOTE.  The Depth is the estimated depth of water from the ADCP face to 
the surface.  The Altitude Above Bottom is the distance of the ADCP 
face from the seafloor.  Altitude Above Bottom is very important for the 
horizontal waves processing. 
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2.3.2 Data Sampling 

 
Set the Waves and Currents Sampling parameters.   
Waves Sampling  
Enter the Burst Duration and the Time Between Start of Bursts.  The recom-
mended setting is 20 minutes Burst Duration with 60 minutes Time Between 
Start of Bursts and 2400 Samples per Burst. 
Currents Sampling  
Enter the Time Between Averaged Ensembles.  The recommended setting is 10 
minutes. 

Start Time – Click Now, to start pinging as soon as the GO button is pressed, or 
select Later for a desired start date and time.  

 
NOTE.  The Date and Time format depends on the settings in Windows®. 
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2.3.3 Data File Output 

 
On the Data File Output dialog, name the Project file something meaningful.  
The output data files will be tied to the setup file name and path.   

The Dep# (Deployment Number) is a file prefix used to indicate and track in-
cremental data deployments and/or sessions in the same directory. 

Click Next. 
Leaving the Enter Advanced Configuration box unchecked will complete the 
wizard and display the summary page (see Real-Time Data Collection Sum-
mary).  If the Enter Advanced Configuration button is selected, the wizard 
will continue to the next page.   
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2.3.4 ADCP Environment 

 
ADCP Depth 

Transducer Altitude.  If the Transducer Altitude is un-checked, it is assumed 
zero.  If it is checked, enter the altitude of the instrument face from the seafloor 
in meters.  The altitude is used in the waves processing to apply the correct gain 
to the lower bins.  An incorrect altitude will cause the pressure- and velocity-
spectra not to match the surface track spectra.  

Force Fixed Depth.  If the box is un-checked, the software uses the instrument 
depth computed by the pressure sensor in each ensemble.  These are averaged to 
calculate mean instrument depth.  If no pressure sensor was available or the 
mean water depth was very large relative to tidal changes, or the pressure sensor 
failed, the nominal water depth can be forced to this value. 

Depth Correction. The depth correction is to allow adding an offset to the 
ADCP’s pressure readings.  If for example, the instrument has been submerged 
for a long time and the pressure sensor depth consistently reads larger than the 
surface track depth, it is likely that the pressure sensor has drifted with time and 
needs to be zeroed at the surface again.   

If the wave height spectra do not agree very closely between the velocity spec-
trum and the pressure or surface track spectrum, it may be because the pressure 
sensor is in error.  An offset in the pressure measurement does not significantly 
affect the pressure spectrum; however, it does have an immediate affect on the 
velocity spectrum.  The locations of the velocity bins below the surface are de-
termined using the mean water depth from the pressure sensor.  An overly large 
pressure sensor reading for depth will cause the velocity spectrum to be high as 
well.  To correct for a pressure sensor reading e.g. if the sensor reads 2.0 meters 
too high, enter the –2.0 meters in Depth Correction. 
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ADCP Heading 

Force Fixed Heading.  The heading is normally measured by the ADCP’s com-
pass.  If for some reason the compass readings were not valid (e.g. the instru-
ment is mounted with a lot of steel nearby), the heading could be measured in-
dependently.  Checking the box and entering a heading offset forces the soft-
ware to use that heading always.  The directional spectra algorithm must know 
the instruments heading to calculate wave direction. 

Magnetic Variation.  Enter the Magnetic Variation for your location in the 
world to have the direction information calculated relative to true North rather 
than magnetic North. 

 

CAUTION.  If you enter a magnetic variation value on the ADCP 
Environment page during reprocessing, it will be added to whatever value 
was initially set when data was collected. 

 

 

NOTE.  When reprocessing data to fix an incorrectly entered magnetic 
variation, enter the difference. 
For example, data was collected using +12.0 for the magnetic variation 
when it should have been set to +14.0.  Enter +2.0 for the correction when 
reprocessing the data. 

 

Force Fixed Pitch.  The pitch is normally measured by the ADCP’s compass.  
Checking the box and entering a fixed pitch forces the software to always use 
that pitch.   

Force Fixed Roll.  The roll is normally measured by the ADCP’s compass.  
Checking the box and entering a fixed roll forces the software to always use that 
roll.   
Depth Cells Used For Waves 

Select the Auto depth cell selection (Top 3) check box, and WavesMon will use 
the top three depth cells for a wave-processing. 

Select Auto Select (Bottom 2) check-box, lets WavesMon use the bottom two 
depth cells for waves-processing (the first depth cell and the mid depth cell). 

Select Remove Top Cell check-box, lets WavesMon use only the bottom two of 
the top 3 depth cells for waves-processing.  

Height Spectrum Depth Cells.  Several depth cells can be chosen, however, if 
high frequency data is of interest, it is recommended that you choose depth cells 
that are as close to the surface as possible.  Make sure that the highest depth cell 
is below the surface at low tide. 

Directional Spectrum Depth Cells.  The direction spectrum algorithm must 
invert a sensor-by-sensor matrix at each frequency band.  Empirically the algo-
rithm appears to achieve good results with three or more depth cells.  Theoreti-
cally, the depth cells should be chosen with some spread and farther up in the 
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water column so that the array has as much aperture as possible.  Be sure that 
you do not choose depth cells beyond the profiling range of the instrument. 

 

Recommended Setting.  It is recommended that you choose the Auto 
depth cell selection (Top 3) check box.  If you want to select which bins 
are used manually this can be done as follows: 
1. Choose Height Spectra Depth Cells that are nearer to the surface for 

better high frequency results.  Make sure that the depth cells are not 
too close to the surface at low tide.   

2. Choose three Directional Spectra Depth Cells that are higher in the 
water column.  Less than three can cause the directional spectra 
algorithm to give poor results.  More than three gives results that are 
more robust but has a dramatic affect on the speed of the algorithm.  
The point of diminishing returns is about three or four depth cells. 

 

Other Options 

Correct for Currents – Uses the mean currents to correct the wave spectra for 
the effects of currents.  A Doppler shifted dispersion relation is used to calculate 
wave number “k.”  This should be applied if the currents near the measurement 
exceed 0.80 m/s.   

Correct for Tilts. The tilts switch can partially correct for a badly tilted ADCP.  
This assumes that the tilt is fixed.  If the pitch or roll is not greater than 10.0 de-
grees it is not recommended to turn this on. Note that the Correct for tilts 
should always be selected when using a Horizontal ADCP. 

Packet Collection Mode.  To use Packet data (i.e. H commands) check the 
Packet Collection Mode box to turn this option on.  The packet mode by de-
fault collect three depth cells near the surface, one at the middle and one at the 
ADCP for the waves processing.  The current profile will be collected indepen-
dently of the packet mode.  Note that packets mode is not available for Horizon-
tal ADCPs at this time. 

 

NOTE.  For information on the H commands, see the WorkHorse 
Commands and Output Data Format Guide. 
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2.3.5 Advanced Processing 

 
Spectrum To use to calculate Wave Parameters.  Select one of the buttons to 
choose which non-directional spectrum to use to scale the directional spectrum 
and calculate wave parameters.   

• VSpec = Velocity Spectrum 

• SSpec = Speed Spectrum 

• PSpec = Pressure Spectrum 

• VPS or SVP (V = Velocity, P= Pressure, S = Surface Track) 
The order is indicative of the priority for applying these sources to the calcula-
tion of wave parameters.  For example: VPS means that orbital Velocity derived 
wave spectra will be used for the determination of Hs, Tp, etc.  If, for some rea-
son Velocity data is screened, then use spectra derived from Pressure to con-
struct wave parameters.  If pressure is also marked bad, then use Surface Track. 

The value of these options is that it capitalizes on our redundant wave mea-
surements to always create wave parameters.  A time series (like that shown in 
the WavesView software) of wave parameters shows gaps or missing data.  We 
found it better to fill in the gaps from our redundant measures.  When Velocity 
is bad Pressure may still be good. The judgment call about what priority (VPS, 
SVP, etc.) to use involves reviewing the quality of these data sources for a spe-
cific deployment.  One can change this by reprocessing the data with a new 
priority setting. 
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How to Process 

This section tells the software how to setup the ADCP.  In real-time, some of 
this information is used to generate commands to be sent to the ADCP, in addi-
tion to guiding the software in its processing. 

Auto Remove Bias.  This switch turns ON and OFF the automatic removal of 
rectification bias. The default is ON and the only reason to turn it OFF is if 
someone has collected data at less than 2Hz.  

Each of the techniques for measuring wave height spectra (pressure, surface-
track, and velocity) has its own set of error sources and its own measurement 
noise.   

We assume that the measured time series is a superposition of the signal 
(waves) and the measurement noise and that the measurement noise is white.  
The Fourier transformation of white noise is white noise.  This white noise has a 
zero mean distribution; however when we square the frequency spectrum to get 
power, the noise becomes always positive.   

This biases the power spectrum by adding a positive offset.  To measure this 
bias the software calculates the mean of the power spectrum at frequencies too 
high for environmental wave energy.  By finding the noise floor of the power 
spectrum, it can then be removed.  This process is done for each of the indepen-
dent height spectra calculations and is required in order to get good agreement 
among the three, because the bias has been subtracted from the overall spec-
trum.  
Time Between Ensembles.  This is the sample rate (0.50 seconds) This sets the 
time between pings in the ADCP for real-time operation.   

This sets the TP-command on the ADCP Commands tab, when collecting full 
profile at e.g. 0.5 sec or the HT-command when collecting in packet mode. 

 
Recommended Setting.  Always Set the Time Between Ensembles to 
0.50 seconds.   

 

 

NOTE.  In packet mode, the TP command can be set to an integer number 
times the sampling rate.  See the Workhorse Technical Manual for more 
details. 

 

Bursts to Process (0=All).  The software will process exactly this many bursts, 
then stop. 

Samples/Burst.  This is the number of ensembles accumulated into a burst for 
waves processing.  Because of the statistical nature of ocean waves, it is rec-
ommended that this correspond to data spanning a range of 5 to 40 minutes.   

 

Recommended Setting.  Choose a Samples/Burst number so that more 
data is collected than required.  For example, 2048 is the nearest power of 
two, 2400 samples allows some data to be potentially lost. 
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Time Between Bursts.  WavesMon uses Time Between Bursts to handle real-
time collection from an ADCP that is burst sampling.  For example if an ADCP 
is collecting 20 minutes (2400 samples per burst) of data every hour on the hour, 
the time between bursts would be set to an hour.   

The ADCP time of first ping command would start the sampling on the next 
hour.  Set the Time Between Bursts accurately or the software may treat good 
data as discontinuous.  Set the burst duration exactly if continuously running.  
This creates the TB-command in the ADCP Commands tab. 

 
Recommended Setting.  A recommended setup is 20 minutes of data 
every hour on the hour. 

 

FFT Length.  The FFT Length control lets one choose the exact number of 
samples in the time series to be Fourier transformed.  This must be a power of 
two and less than or equal to the Ensembles Per Burst.  If an erroneous value is 
chosen the software will pick the nearest power of two that is less than or equal 
to the value chosen and the Ensembles per Burst.  This value would differ 
from the Ensembles per Burst if the ADCP were collecting bursts that are not a 
power two.   

 

Recommended Setting.  Set the Samples per Burst to 2400 (20 minutes 
of data) so that the current profile will have 3 averaging intervals 6 minutes 
long and the FFT will have 2048 samples.   

 

Frequency Bands.  The number of frequency bands must be a power of two and 
the maximum is half the FFT Length.  Band averaging smoothes the data by 
averaging adjacent frequency bands from the raw frequency spectrum.  Band 
averaging also increases the number of degrees of freedom of the cross-spectral 
matrix because each frequency band is independent.  Band averaging improves 
the results and speed of the directional spectra algorithm so it is recommended 
that at least some be done.   

 

Recommended Setting.  Using 128 Frequency Bands gives nice 
frequency resolution and still smoothes the data by a factor of square root 
eight.  If very long waves are of interest, less band averaging (512 
Frequency Bands) will give greater frequency resolution at these 
frequencies.  Environments that see 20 second period waves and larger 
should use at least 256 Frequency Bands.   

 

Lower Frequency Thresholds.  Set the Lower Frequency Threshold for all 
three spectra. 

Upper Frequency Thresholds.  The Frequency threshold is calculated automat-
ically for each height spectrum type (pressure, surface track, velocity).  Howev-
er, if for some reason the algorithm is not handling some set of environmental 
conditions properly you can manually set the upper frequency cutoff.  This be-
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comes important to such calculations as significant wave height and determining 
the range of frequencies over which to search for a peak.   

 
Recommended Setting.  The software automatically calculates the upper 
cutoff frequency. User input will be ignored.  

 

Sea Swell Transition Frequency.  The default value is 0.125 Hz.  This number 
defines the boundary condition for searching for Sea and Swell.  To display Sea 
and Swell parameters right-click on either the Time Series chart, or the Direc-
tional Spectrum (Polar) chart, and select Data selection....  From there you 
can select the Sea and Swell parameters. 

Number of Angles.  The number of angles determines the angular resolution of 
the directional spectrum.  Dividing the full circle into 90 pie slices gives good 
resolution without overkill.   

 

Recommended Setting.  Set the number of angles to 90.  This is the 
number of slices the 360-degree, full circle is divided into for the directional 
spectra calculation.  You can use as high as 360 slices of one-degree 
width, however, the resulting spectrum does not change much, and there is 
four times as much data to move and plot.  Less than 90 angle divisions 
will also work fine, however poor angular resolution will begin to degrade or 
smear the data. 

 

IMLM Iterations.  The IMLM technique corrects MLM spectra for directional 
spreading caused by the MLM algorithm.  It makes narrower, more true to life 
directional spectra.  The point of diminishing returns is about 3 IMLM itera-
tions.  Each iteration makes the processing take longer.  Three iterations or more 
appears to produce a directional spectrum that converges with the data.  That is 
to say, 20 iterations yields a spectrum that is about the same as 3, yet three itera-
tions is a huge improvement over the original MLM estimate (0 iterations).   

 

Recommended Setting.  Choose one IMLM iterations for best results.  
Each iteration makes the processing take longer.  One iteration appears to 
produce a directional spectrum that converges with the data.   
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2.3.6 Data Screening 

 
Data Screening 

Minimum – This is the minimum change in the time-series data. 
Spec STD Threshold – The allowed STD of the time-series. 

STD Threshold – Velocity and surface time series are screened before being 
Fourier transformed.  The primary screening is the wild point editor.  It throws 
out and interpolates data points that are more than “n” standard deviations away 
from the mean.  The STD Threshold default is set to four.   

Max Change – This is the maximum change in the time-series data. 

Percent Good Threshold – If the percent of good data in a burst is less then the 
threshold WavesMon will not processing the burst.  

Max Ensemble Timing Deviation – In the event that data communication is 
unreliable, the software will accept deviations in the time stamps for individual 
ensembles (for example, some data was lost).  If large gaps (greater than 5 
seconds) occur in the data, it will reject the data as being discontinuous.  This 
keeps the waves processing from averaging or “FFT’ing” data from two differ-
ent periods yet allows small glitches.   

Small Wave Screening Frequency – This allows the pressure sensor to im-
prove the wave height spectrum at low frequencies.  When the wave height is 
very small (e.g. Hs < 0.20 m), the signal to noise ratio at very long wavelengths 
is poor for the orbital velocity based spectrum.  Because long waves can be 
measured deeper, the pressure sensor can be used to measure this region of the 
spectrum.  When waves are very small, if one sees spurious peak period (Tp) 
showing very long periods, this switch will improve the spectrum and the ro-
bustness of Tp.  



 WavesMon User's Guide 

P/N 957-6232-00 (May 2010) page 31 

Small Wave Screening Height – Screen all height data below the entered 
value. This option is useful when processing waves data from a horizontal 
system. 

2.3.7 Processing and File Outputs 

 
In the What to Process section, the Process and Save check boxes let you 
choose what data to process and what data to save in the Waves Record (*.wvs) 
file.  Note there is some dependency between the selected data types.  One can-
not do a Directional Spectrum if no Velocity Data was processed in the first 
place.  Likewise, one cannot save a Surface Spectrum if it was not processed to 
begin with.  This allows the flexibility to process and display the data but just 
store spectra or wave parameters in the output file.   

 

NOTE.  Including Velocity, Surface, or Pressure Time Series in the 
saved Waves Record makes very large data files.  If you do not require 
time series data to be output, do not select them in the What to Process, 
Save box.   
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2.3.8 Advanced File Outputs 

 
The Advanced File Outputs page allows you to select what files to output.   
Raw Data 

Raw data can be saved to a file or sent to the COM port.   
Wave Parameters Log 

The Wave Parameters Log is a brief summary containing wave parameters 
(Hs, Tp, Dp, and averaged current profile data).  Select any output options that 
you would like.   

Check the Save DHI Format File check-box to save processed waves data to 
DHI’s MIKE00 format.   

To view the formats, click the Show button (see Wave Parameters Log For-
mats).   
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Figure 29. Wave Log Format 
Processed Waves Data 

Select the Processed Waves Data check box to create a waves record file 
(*.wvs).   

Check the Save to Text File to create an ASCII text file for each burst for each 
of the selected data types.  The text file has a header describing the contents of 
the file.  These files can be loaded into Matlab or a spreadsheet for those who 
would like to process or analyze the data on their own.  This option is recom-
mended for users that would like to batch process text files for a whole data set.   
Currents Data 

Select the Currents Data check box to create a data file with just the currents 
data.   

 

Recommended Setting.  For Real-Time data collection, it is 
recommended that you select the Raw Data File box to save the ADCP 
raw data file. 

 

Check the Enable Graphical Outputs box to enable saving image files (see 
Graphical Outputs). 

Check the Enable Alias Data Outputs box to copy the processed waves, waves 
parameters log, current, and raw-data to another disk or shared disk.  
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2.3.9 Graphical Outputs 

 
Save Images – Saves the WavesMon screens (currents to the left, waves to the 
right) every time they are updated with new data, to PNG image files.  This is 
used for saving and/or displaying of real-time data images (e.g. for a real-time 
web-pages). 

 

NOTE.  This page will be skipped unless the Enable Graphical Outputs 
box is selected on the Advanced File Outputs screen. 

 

2.3.10 ADCP Commands 

 
This shows you the Software Generated Commands in the window to the left 
generated by WavesMon based on the choices you made in the other dialogs.  
The User Override allows you to enter an ADCP command file for your own 
commands or to over-ride a program set command.  The commands entered in 
the User Override Commands area will be sent to the instrument last so any 
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commands that you choose will override the default commands generated by 
WavesMon.  Edit if necessary and click OK. 

Example:  You are collecting data in Real Time (cabled) but you would like to 
also save data to the ADCP’s internal recorder.  The default CF command for 
real time does not enable the recorder.  Enter CF11111 in the User Override 
window to enable both the serial port and the internal recorder.   

 

NOTE.  Commands preceded by a semicolon are ignored as commands 
and treated as comments. 

 

2.3.11 Real-Time Data Collection Summary 

 
Review the Configuration and Deployment Summary.  To save the summary, 
click Save Summary.   

Click Finish to exit the Project Wizard.   

 
NOTE.  The summary does not include or take into consideration any 
commands entered in the User Override column (see ADCP Commands).   
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2.4 Reprocessing Raw ADCP Data 
Raw ADCP data can be reprocessed using WavesMon to create the Waves 
Record (*.wvs) file.  In real-time, raw data is saved and processed.  In Playback, 
previously recorded raw data is processed.  Raw data files created by a self-
contained ADCP can be stored separately on the ADCP recorder, downloaded to 
a PC file, and saved by WavesMon during processing.   

 
NOTE.  A sample raw data file is included on the Waves CD.  It is not 
copied to your hard drive during software installation. 

 

a. Start WavesMon. 

b. On the File menu, click New Project.   
c. At the Select Input Type dialog, choose Reprocess.  

d. Follow through the wizard screens by entering the needed information and 
then pressing Next to move to the next screen.  For details on how to set 
each page, see the following sections. 

• Select Raw File 
• Deployment Info 
• Data Sampling 
• Data File Output 

e. Review the summary. 

f. Click Finish.   

g. Click the  button on the WavesMon toolbar.   

 
Figure 30. Processing Data Toolbar 

h. If the results are not what you expected, click the Stop button on the toolbar 
and edit the project (see Editing Projects).   
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2.4.1 Select Raw File 

 
Select Raw Data File for Reprocessing – Use the Browse button to select the da-
ta file. 

File Information – The Data Type will show Ensembles if the data file has raw 
ensemble data or Packets if the raw data file uses Packet data. 

Skip N Bytes Into File or Skip N Bursts Into File – Use these functions to skip in-
to the file to a specific location.  For example, if the ADCP data collection 
started on the bench, then was deployed on the ocean bottom later, the starting 
data is bad.  To skip this data, offset into the file to the good data.  You may 
need to try a few times if the exact offset is important.   

2.4.2 Deployment Info 

 
Enter the Altitude Above Bottom when the ADCP was deployed.   
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2.4.3 Data Sampling 

 
The Data Sampling screen shows the Waves and Currents Sampling parame-
ters used during data collection.  No changes are allowed. 

2.4.4 Data File Output 

 
On the Data File Output dialog, name the Project file something meaningful.  
The output data files will be tied to the project file name and path.   

Leaving the Enter Advanced Configuration box unchecked will complete the 
wizard and display the summary page (see Processing Summary).  If the Enter 
Advanced Configuration button is selected, the wizard will continue to the 
next page.   

 

NOTE.  The rest of the wizard screens are the same as for Real-Time data 
collection.  For more information on the screen settings, see the 
appropriate section in this manual. 
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2.4.5 Processing Summary 

 
Review the summary.   

To save the Configuration and Deployment Summary, click Save Summary.   

Click Finish. 
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2.5 Editing Projects 
Once you use the Project Wizard to process a data file (see Reprocessing Raw 
ADCP Data) WavesMon creates a Playback Configuration node.  The Play-
back Configuration is a copy of the Field Configuration information used to 
collect the data.  No changes can be made to the original Field Configuration 
or Playback Configuration nodes.   

Configuration nodes can be Duplicated, Deleted (only the copies), and Re-
named as needed.  Any editing changes made to the configuration nodes are 
saved to the project file.   

Right-clicking on a Field Configuration or Playback Configuration node will 
display the following menu. 

 
Figure 31. Project Management Window Menu 

2.5.1 Duplicate 
Use this function to duplicate the configuration node.  If the Field Configura-
tion node is duplicated, it will create a new Playback Configuration node. 

2.5.2 Properties 
Right-click on the duplicate Playback Configuration node and select Proper-
ties.  Select the page you wish to change.  Enter your changes and click OK.  
Save the project file if you make changes by selecting File, Save Project.  Start 
playback again by clicking the  button.   

The following screens are the same as for Real-Time data collection.  For more 
information on the screen settings, see the appropriate section in this manual.  
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• ADCP Environment  
• Advanced Processing 
• Data Screening 
• Processing and File Outputs 
• Advanced File Outputs 
• Graphical Outputs 
• ADCP Commands 
• Real-Time Data Collection Summary 

2.5.3 Set as Active Configuration 
The active configuration node is in bold. To change between configuration 
nodes, right-click the on the configuration node name and select Set as Active 
Configuration. Only one configuration node may be active at a time. 

2.5.4 Delete 
Use this function to delete a configuration node.  The Field Configuration node 
and the original Playback Configuration node can not be deleted. 

2.5.5 Rename 
Use this function to rename the configuration node.  To change the name of the 
node, right-click the on the configuration node and click Rename.   

2.5.6 Data File 
Right-clicking on a data file and selecting Properties will display the Raw Da-
ta File Properties box.  

 
2.5.7 Adding Raw Data Files 

If you have multiple data files that need to be processed, do the following. 

a. Duplicate the original Playback Configuration node by right-clicking on the 
Playback Configuration node and select Duplicate as Playback. 

b. Right-click on the duplicate Playback Configuration node and select Add 
Raw Data File. 

c. Select the waves raw data file (*.000 or *.PD0). 

d. Click Open. 
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e. Repeat steps “b” through “d” as needed to add multiple data files.   

3 Command Line Options 
To start WavesMon from a command line or in a batch file for data collect-
ing/processing automatically, WavesMon needs following parameters:  
WavesMon.exe [ProjectFileName.prj] [Auto] 

The software will open the setup file, collect and process the number of bursts 
requested in the setup, output processed data according to the setup file options. 

The command line options for WavesMon are as follows: 

WavesMon.exe [ProjectFileName.prj] [Auto] 

• The primary command line argument is the setup file name.  By passing 
the setup file name to the program one can automatically load a setup 
file without having to go through the file open dialog.  Be sure to always 
pass a setup file name as the first command line option. 

• The next argument is optional.  If 2nd argument is "Auto" WavesMon will 
start automatically. 

Example of a batch file: 
@ECHO OFF 
CD C:\Program Files\RD Instruments\WavesMon 
WavesMon.exe C:\TRDI\WAVES\WAVES.PRJ Auto 
 

 

NOTE.  Some commands (MSDOS®) do not handle a space in a path in a 
batch file like Windows® does. 

 

4 WavesMon File Formats 
The file extensions have the following meanings. 
Table 1: File Naming Conventions 
Extension Description 
*.prj Project files created by WavesMon based on how the program options are setup. 
*.wvs Waves Record file created by processing data using WavesMon and viewed with Waves-

View. 
*.wsp Workspace file for WavesMon.  Saves how the screens looked when the file was saved.   
*.txt Text format waves output   
 

4.1 WavesMon Input Data Formats 
ADCP Ensemble or Packet Data.  The program input is ADCP ensembles col-
lected at 2 Hz.  The ensembles must have un-transformed beam radial velocity 
data.  This data can be read from the COM port or from files. 

Project Files.  The software determines its mode of operation and the way to 
process the data from the project file that is loaded at startup.   
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4.2 WavesMon Output Data Formats 
The Advanced File Outputs page allows selecting what output files are created 
(see Advanced File Outputs). 

Raw Data.  WavesMon can write out the raw ADCP ensemble data to files and 
to a COM port.  The file name must have a three digit numeric extension.  If the 
file size exceeds the maximum, the numeric file extension will be incremented 
and a new file started.  A new file is started automatically every time the soft-
ware is run. 

Waves Parameters Log.  WavesMon can also output a waves parameters log 
file.  This file contains an averaged transformed current profile, and wave para-
meters (Hs, Tp, Dp).  This data can also be written to COM port.  This data is 
intended for integration with other systems or software.  See Wave Parameters 
Log Formats for details. 

Processed Waves Data.  The main output of WavesMon is the waves record.  A 
waves record (*.wvs) is an extensible binary structure very much like an ADCP 
ensemble.  The contents of the waves record can be selected in the project wi-
zard.  The waves record always contains the necessary information to interpret 
and process the waves data.  The advantage of the waves record is that it con-
denses Giga-bytes of raw ensemble data into a compact waves data set.   

The waves record can contain raw data and/or processed waves data.  For ex-
ample 400 Mega-bytes of raw ensemble data can be condensed to 3 megabytes 
of processed waves data.  The WavesView software is designed to read and dis-
play waves records (*.wvs files).   

Currents Data.  Currents data files contain just currents data.   

Text Files.  Text files of the time series and spectra data can be output for each 
burst if they are selected.  For those who would like to do their own analysis 
these files can be imported into MatLab or a spreadsheet program like Excel. 

Images.  Turn on the Save Images function on the Graphical Outputs page 
(see Graphical Outputs).  This allows you to save screen images to *.PNG for-
mat files.   
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4.3 Wave Parameters Log Formats 
The Waves Parameters Log is a brief summary containing wave parameters 
(Hs, Tp, Dp, and averaged current profile data).  There are 10 formats available 
(0 through 11, with formats 7 and 9 not available).  

4.3.1 Format 0 
Table 2: Waves Parameters Log: Format 0 
String Description 

Header  (0x7f78) 

YY 
MM 
DD 
HH 
mm 
ss 
cc 

Date and time field.  Leading zeros are always included to maintain fixed length. 
YY = 2 fixed digits for year, MM= 2 fixed digits for month, and DD= 2 fixed digits 
for day. 
HH = 2 fixed digits of hours, mm = 2 fixed digits of minutes, ss = 2 fixed digits of 
seconds, and cc = 2 fixed digits of 1/100th seconds. 

Depth  Water level (from pressure sensor) (decimeters) 

Coordinate system  (0 = beam, 1 = earth, 2 = ship) 

Hs Significant Wave Height (meters)  

Tp  Peak Wave Period (seconds) - period associated with the largest peak in the 
power spectrum 

Dp  Peak Wave Direction (degrees) - peak direction at the peak period. 

Reserved1 Reserved for TRDI use. 

Reserved2 Reserved for TRDI use. 

Bins  

bin1beam1 velocity  bin1beam1 velocity (mm/s) 

bin1beam2 velocity  bin1beam2 velocity (mm/s) 
 

 

NOTE.  Format 0 is updated with every averaged current profile.  Binary 
format with 16 bit signed fields. 

 

04Hs M=
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4.3.2 Format 1 
Table 3: Waves Parameters Log: Format 1 
String Description 

Header  (0x7f78) 

YY 
MM 
DD 
HH 
mm 
ss 
cc 

Date and time field.  Leading zeros are always included to maintain fixed length. 
YY = 2 fixed digits for year, MM= 2 fixed digits for month, and DD= 2 fixed digits 
for day. 
HH = 2 fixed digits of hours, mm = 2 fixed digits of minutes, ss = 2 fixed digits of 
seconds, and cc = 2 fixed digits of 1/100th seconds. 

Depth  Water level (from pressure sensor) (decimeters) 

Coordinate system  (0 = beam, 1 = earth, 2 = ship) 

Hs Significant Wave Height (meters)  

Tp  Peak Wave Period (seconds) - period associated with the largest peak in the 
power spectrum 

Dp  Peak Wave Direction (degrees) - peak direction at the peak period. 

Reserved1 Reserved for TRDI use. 

Reserved2 Reserved for TRDI use. 

Bins  

bin1beam1 velocity  bin1beam1 velocity (mm/s) 

bin1beam2 velocity  bin1beam2 velocity (mm/s) 

↓  

 

 

NOTE.  Format 1 is like format 0 only in ASCII format with 16 bit signed 
fields.  ASCII text uses twice as many bytes as the binary format.  Format 
1 is updated with every averaged current profile.   

 

Example: 
******** 
32632 
378 
1 
8 
22 
12 
49 
0 
18 
↓ 
↓ 
 
******** 
 

04Hs M=
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4.3.3 Format 2 
Table 4: Waves Parameters Log: Format 2 
String Description 

Burst# Burst number 

YYMMDDHHmmsscc Date and time field.  Leading zeros are always included to maintain fixed length. 
YY = 2 fixed digits for year, MM= 2 fixed digits for month, and DD= 2 fixed digits 
for day. 
HH = 2 fixed digits of hours, mm = 2 fixed digits of minutes, ss = 2 fixed digits of 
seconds, and cc = 2 fixed digits of 1/100th seconds. 

Hs Significant Wave Height (meters)  

Tp Peak Wave Period (seconds) - period associated with the largest peak in the 
power spectrum 

Dp Peak Wave Direction (degrees) - peak direction at the peak period. 
 

 
NOTE.  Updated with each burst of waves data.  ASCII text, space 
delimited line for each burst of data. 

 

Example:   
    8 01082213190018 -0.00 -0.10 -1.0  
    9 01082213490018 0.84 7.70 281.0  
   10 01082214190018 0.82 8.20 280.0  
   11 01082214490018 0.85 8.20 263.0  
   12 01082215190018 0.87 7.30 258.0  
   13 01082215490018 0.74 6.50 268.0  
   14 01082216190018 0.84 7.70 268.0  
   15 01082216490018 0.76 7.70 293.0  
 

04Hs M=
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4.3.4 Format 3 
Table 5: Waves Parameters Log: Format 3 
String Description 

Burst# Burst number 

YY,MM,DD,HH,mm,ss,cc Date and time field.  Leading zeros are always included to maintain fixed length. 
YY = 2 fixed digits for year, MM= 2 fixed digits for month, and DD= 2 fixed digits 
for day. 
HH = 2 fixed digits of hours, mm = 2 fixed digits of minutes, ss = 2 fixed digits of 
seconds, and cc = 2 fixed digits of 1/100th seconds. 

Hs Significant Wave Height (meters)  

Tp Peak Wave Period (seconds) - period associated with the largest peak in the 
power spectrum 

Dp Peak Wave Direction (degrees) - peak direction at the peak period. 

Depth Water level (from pressure sensor) (decimeters) 

#bins Number of bins 

depthlevel1Magnitude Depth Level 1 Magnitude (m/s) 

depthlevel1Direction Depth Level 1 Direction (deg) 

↓  

depthlevel5Magnitude Depth level 5 Magnitude (m/s) (m/s) 

depthlevel5Direction Depth level 5 Direction (deg) 
 

 

NOTE.  Updated with each burst of waves data.  ASCII text, comma 
delimited line for each burst of data.  Format 3 always averages the profile 
into five depth levels. 

 

Example: 
    8,01,08,22,13,19,00,18,-0.00,-0.10,-1.0,18.700,5,0.036, 10,0.046,123,0.060,121,0.190, 59,0.041,118 
    9,01,08,22,13,49,00,18,0.84,7.70,281.0,18.600,5,0.011, 71,0.062,122,0.071,126,0.216, 52,0.027,150 
   10,01,08,22,14,19,00,18,0.82,8.20,280.0,18.400,5,0.020, 21,0.068,141,0.067,144,0.188, 57,0.078,106 
   11,01,08,22,14,49,00,18,0.85,8.20,263.0,18.300,5,0.031,  6,0.070,159,0.066,155,0.168, 63,0.084, 97 
   12,01,08,22,15,19,00,18,0.87,7.30,258.0,18.200,5,0.030,342,0.068,165,0.079,147,0.189, 69,0.067,111 
   13,01,08,22,15,49,00,18,0.74,6.50,268.0,18.000,5,0.071, 10,0.066,194,0.087,165,0.205, 82,0.049,159 

 

04Hs M=
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4.3.5 Format 4 
Table 6: Waves Parameters Log: Format 4 
String Description 

Burst# Burst number 

YY,MM,DD,HH,mm,ss,cc Date and time field.  Leading zeros are always included to maintain fixed length. 
YY = 2 fixed digits for year, MM= 2 fixed digits for month, and DD= 2 fixed digits 
for day. 
HH = 2 fixed digits of hours, mm = 2 fixed digits of minutes, ss = 2 fixed digits of 
seconds, and cc = 2 fixed digits of 1/100th seconds. 

Hs Significant Wave Height (meters)  

Tp Peak Wave Period (seconds) - period associated with the largest peak in the 
power spectrum 

Dp Peak Wave Direction (degrees) - peak direction at the peak period. 

Depth Water level (from pressure sensor) (millimeters) 

#bins Number of bins 

depthlevel1Magnitude Depth Level 1 Magnitude (m/s) 

depthlevel1Direction Depth Level 1 Direction (deg) 

↓  

depthlevelNMagnitude Depth Level N Magnitude (m/s) (m/s) 

depthlevelNDirection Depth Level N Direction (deg) 
 

 

NOTE.  Updated with each burst of waves data.  ASCII text, comma 
delimited line for each burst of data.  Format 4 is like Format 3 only it 
outputs a full resolution profile. 

 

Example: 
    8,01,08,22,13,19,00,18,-0.00,-0.10,-1.0,18781.000,43,0.077,310,0.078,316,0.066,329,0.059,  7,0.044, 
38,0.048, 67,0.059, 80,0.063, 93,0.060, 
95,0.060,101,0.048,108,0.043,120,0.045,132,0.046,139,0.050,146,0.044,155,0.043,152,0.035,145,0.029,145,0.0
44,139,0.060,122,0.076,116,0.084,114,0.135,100,0.108, 49,0.391, 23,0.525, 55,0.127, 63,0.197, 76,0.158, 
90,0.099, 98,0.084,115,0.065,101,0.067, 
83,0.052,107,0.039,103,0.045,127,0.049,159,0.045,140,0.021,205,0.048,222,0.078,249,0.112,208 
    9,01,08,22,13,49,00,18,0.84,7.70,281.0,18682.000,43,0.065,287,0.072,295,0.043,311,0.019, 21,0.036, 
98,0.058,105,0.072,109,0.077,108,0.080,109,0.079,111,0.070,114,0.058,114,0.060,126,0.050,134,0.057,139,0.0
54,143,0.045,156,0.043,152,0.046,143,0.055,143,0.069,134,0.086,131,0.098,124,0.165, 93,0.140, 25,0.457, 
20,0.507, 53,0.118, 57,0.229, 71,0.180, 78,0.135, 83,0.117, 87,0.103, 83,0.073, 83,0.063, 
96,0.046,110,0.027,204,0.058,234,0.078,226,0.092,219,0.115,249,0.100,237,0.134,194 
 

04Hs M=
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4.3.6 Format 5 
Table 7: Waves Parameters Log: Format 5 
String Description 

Burst# Burst number 

YY,MM,DD,HH,mm,ss,cc Date and time field.  Leading zeros are always included to maintain fixed length. 
YY = 2 fixed digits for year, MM= 2 fixed digits for month, and DD= 2 fixed digits 
for day. 
HH = 2 fixed digits of hours, mm = 2 fixed digits of minutes, ss = 2 fixed digits of 
seconds, and cc = 2 fixed digits of 1/100th seconds. 

Hs Significant Wave Height (meters)  

Tp Peak Wave Period (seconds) - period associated with the largest peak in the 
power spectrum 

Dp Peak Wave Direction (degrees) - peak direction at the peak period. 

Depth Water level (from pressure sensor) (millimeters) 

H1/10 H1/10 (10% highest waves) = 1.27 * Hs 

Tmean 

Mean Period (seconds)  

#bins Number of bins 

depthlevel1Magnitude Depth Level 1 Magnitude (m/s) 

depthlevel1Direction Depth Level 1 Direction (deg) 

↓  

depthlevelNMagnitude Depth Level N Magnitude (m/s) 

depthlevelNDirection Depth Level N Direction (deg) 
 

 

NOTE.  Updated with each burst of waves data.  ASCII text, comma 
delimited line for each burst of data.  Format 5 is like Format 3 only it 
outputs a full resolution profile and adds H1/10 and Tmean. 

 

Example: 
    8,01,08,22,13,19,00,18,-1.00,-1.00,-1.0,18781.000,-1.00,-1.00,43,0.077,310,0.078,316,0.066,329,0.059,  
7,0.044, 38,0.048, 67,0.059, 80,0.063, 93,0.060, 
95,0.060,101,0.048,108,0.043,120,0.045,132,0.046,139,0.050,146,0.044,155,0.043,152,0.035,145,0.029,145,0.0
44,139,0.060,122,0.076,116,0.084,114,0.135,100,0.108, 49,0.391, 23,0.525, 55,0.127, 63,0.197, 76,0.158, 
90,0.099, 98,0.084,115,0.065,101,0.067, 
83,0.052,107,0.039,103,0.045,127,0.049,159,0.045,140,0.021,205,0.048,222,0.078,249,0.112,208 
    9,01,08,22,13,49,00,18,0.84,7.70,281.0,18682.000,1.06,6.00,43,0.065,287,0.072,295,0.043,311,0.019, 
21,0.036, 
98,0.058,105,0.072,109,0.077,108,0.080,109,0.079,111,0.070,114,0.058,114,0.060,126,0.050,134,0.057,139,0.0
54,143,0.045,156,0.043,152,0.046,143,0.055,143,0.069,134,0.086,131,0.098,124,0.165, 93,0.140, 25,0.457, 
20,0.507, 53,0.118, 57,0.229, 71,0.180, 78,0.135, 83,0.117, 87,0.103, 83,0.073, 83,0.063, 
96,0.046,110,0.027,204,0.058,234,0.078,226,0.092,219,0.115,249,0.100,237,0.134,194 
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4.3.7 Format 6 
Table 8: Waves Parameters Log: Format 6 
String Description 

Burst# Burst number 
YY,MM,DD,HH,mm,ss,cc Date and time field.  Leading zeros are always included to maintain fixed length. 

YY = 2 fixed digits for year, MM= 2 fixed digits for month, and DD= 2 fixed digits 
for day. 
HH = 2 fixed digits of hours, mm = 2 fixed digits of minutes, ss = 2 fixed digits of 
seconds, and cc = 2 fixed digits of 1/100th seconds. 

Hs Significant Wave Height (meters)  
Tp Peak Wave Period (seconds) - period associated with the largest peak in the 

power spectrum 
Dp Peak Wave Direction (degrees) - peak direction at the peak period. 
Depth Water level (from pressure sensor) (millimeters) 

H1/10 H1/10 (10% highest waves) = 1.27 * Hs 

Tmean 

Mean Period (seconds)  
#bins Number of bins 
depthlevel1Magnitude Depth Level 1 Magnitude (m/s) 
depthlevel1Direction Depth Level 1 Direction (deg) 

↓  

depthlevelNMagnitude Depth Level N Magnitude (m/s) 
depthlevelNDirection Depth Level N Direction (deg) 
 

 

NOTE.  Updated with every averaged current profile.  ASCII text, comma 
delimited line for each burst of data.  Format 6 is similar to Format 3, only it 
outputs a full resolution profile. 

 

Example: 
    8,01,08,22,13,49,00,18,-1.00,-1.00,-1.0,18781.000,-1.00,-1.00,43,0.065,287,0.072,295,0.043,311,0.019, 21,0.036, 
98,0.058,105,0.072,109,0.077,108,0.080,109,0.079,111,0.070,114,0.058,114,0.060,126,0.050,134,0.057,139,0.054,143,0.045,1
56,0.043,152,0.046,143,0.055,143,0.069,134,0.086,131,0.098,124,0.165, 93,0.140, 25,0.457, 20,0.507, 53,0.118, 57,0.229, 
71,0.180, 78,0.135, 83,0.117, 87,0.103, 83,0.073, 83,0.063, 
96,0.046,110,0.027,204,0.058,234,0.078,226,0.092,219,0.115,249,0.100,237,0.134,194 
    9,01,08,22,14,19,00,18,0.84,7.70,281.0,18682.000,1.06,6.00,43,0.043, 24,0.034,  
8,0.035,348,0.037,338,0.019,344,0.015, 
42,0.020,101,0.036,118,0.058,128,0.075,134,0.081,135,0.080,141,0.082,140,0.065,145,0.058,150,0.056,162,0.053,177,0.050,1
71,0.054,176,0.060,165,0.066,156,0.087,145,0.097,140,0.150, 95,0.180, 22,0.484, 29,0.343, 57,0.131, 71,0.179, 86,0.158, 
90,0.120, 91,0.094, 95,0.073, 99,0.068,119,0.070,101,0.064,109,0.067,118,0.080,117,0.102,100,0.106, 95,0.120, 82,0.134, 
81,0.067, 39 
 

4.3.8 Format 7 

 
NOTE.  Format 7 is not available.   
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4.3.9 Format 8 
Table 9: Waves Parameters Log: Format 8 
String Description 
Burst# Burst number 
YY,MM,DD,HH,mm,ss,cc Date and time field.  Leading zeros are always included to maintain fixed length. 

YY = 2 fixed digits for year, MM= 2 fixed digits for month, and DD= 2 fixed digits 
for day. 
HH = 2 fixed digits of hours, mm = 2 fixed digits of minutes, ss = 2 fixed digits of 
seconds, and cc = 2 fixed digits of 1/100th seconds. 

Hs Significant Wave Height (meters)  
Tp Peak Wave Period (seconds) - period associated with the largest peak in the 

power spectrum 
Dp Peak Wave Direction (degrees) - peak direction at the peak period. 
Depth Water level (from pressure sensor) (millimeters) 
H1/10 H1/10 (10% highest waves) = 1.27 * Hs 
Tmean 

Mean Period (seconds)  
Dmean Mean Peak Wave Direction (degrees) 
#bins Number of bins 
depthlevel1Magnitude Depth Level 1 Magnitude (m/s) 
depthlevel1Direction Depth Level 1 Direction (deg) 
↓  
depthlevelNMagnitude Depth Level N Magnitude (m/s) 
depthlevelNDirection Depth Level N Direction (deg) 
 

 

NOTE.  Updated with each burst of waves data.  ASCII text, comma 
delimited line for each burst of data.  Like Format 3 only it outputs a full 
resolution profile.   

 

Example: 
   10,01,08,22,14,19,00,18,0.82,8.20,280.0,18553.000,1.04,5.90,260.0,43,0.043, 24,0.034,  
8,0.035,348,0.037,338,0.019,344,0.015, 
42,0.020,101,0.036,118,0.058,128,0.075,134,0.081,135,0.080,141,0.082,140,0.065,145,0.058,150,0
.056,162,0.053,177,0.050,171,0.054,176,0.060,165,0.066,156,0.087,145,0.097,140,0.150, 
95,0.180, 22,0.484, 29,0.343, 57,0.131, 71,0.179, 86,0.158, 90,0.120, 91,0.094, 95,0.073, 
99,0.068,119,0.070,101,0.064,109,0.067,118,0.080,117,0.102,100,0.106, 95,0.120, 82,0.134, 
81,0.067, 39 
   11,01,08,22,14,49,00,18,0.85,8.20,263.0,18424.000,1.08,6.00,260.0,43,0.072, 41,0.057, 
28,0.051,  
8,0.040,340,0.035,321,0.030,323,0.013,351,0.012,185,0.046,173,0.075,159,0.087,153,0.087,149,0.
076,154,0.070,155,0.065,164,0.059,176,0.052,193,0.057,205,0.060,195,0.071,177,0.085,167,0.100,
158,0.114,143,0.143, 82,0.229, 13,0.539, 38,0.146, 65,0.153, 98,0.175,103,0.148, 97,0.116, 
95,0.098, 95,0.073, 99,0.056,106,0.049,102,0.059, 89,0.083, 94,0.101,104,0.116,100,0.136, 
90,0.102, 88,0.095, 62,0.204, 18 
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4.3.10 Format 9 
Table 10: Waves Parameters Log: Format 9 
String Description 
Burst# Burst number 
YY,MM,DD,HH,mm,ss,cc Date and time field.  Leading zeros are always included to maintain fixed length. 

YY = 2 fixed digits for year, MM= 2 fixed digits for month, and DD= 2 fixed digits 
for day. 
HH = 2 fixed digits of hours, mm = 2 fixed digits of minutes, ss = 2 fixed digits of 
seconds, and cc = 2 fixed digits of 1/100th seconds. 

Hs Significant Wave Height (meters)  
Tp Peak Wave Period (seconds) - period associated with the largest peak in the 

power spectrum 
Dp Peak Wave Direction (degrees) - peak direction at the peak period. 
Tp_Sea Peak Sea Wave Period (seconds) - period associated with the largest peak in 

the sea region of the power spectrum. (see Note) 

Dp_Sea Peak Sea Wave Direction (degrees) - peak sea direction at the peak period in 
the sea region. (see Note) 

Hs_Sea Significant Wave Height in the sea region of the power spectrum. 

Tp_Swell Peak Swell Wave Period (seconds) - period associated with the largest peak in 
the swell region of the power spectrum. (see Note) 

Dp_Swell Peak Swell Wave Direction (degrees) - peak swell direction at the peak period 
in the swell region. (see Note) 

Hs_Swell Significant Wave Height in the swell region of the power spectrum. 
Depth Water level (from pressure sensor) (millimeters) 
Hmax Maximum wave height (meters) as determined by Zero-Crossing analysis of the 

surface track time series.   
Tmax Maximum Peak Wave Period (seconds) as determined by Zero-Crossing 

analysis of the surface track time series.  

H1/3 Significant wave height of the largest 1/3 of the waves in the field as determined 
by Zero-Crossing analysis of the surface track time series. 

T1/3 The period associated with the peak wave height of the largest 1/3 of the waves 
in the field as determined by Zero-Crossing analysis of the surface track time 
series. 

Hmean The mean significant wave height of the waves in the field as determined by 
Zero-Crossing analysis of the surface track time series. 

Tmean The period associated with the mean significant wave height of the waves in the 
field as determined by Zero-Crossing analysis of the surface track time series. 

H1/10 Significant wave height of the largest 1/10 of the waves in the field as deter-
mined by Zero-Crossing analysis of the surface track time series. 

T1/10 The period associated with the peak wave height of the largest 1/10 of the 
waves in the field as determined by Zero-Crossing analysis of the surface track 
time series. 

Dmean Mean Peak Wave Direction (degrees) 
#bins Number of bins 
depthlevel1Magnitude Depth Level 1 Magnitude (m/s) 
depthlevel1Direction Depth Level 1 Direction (deg) 
↓  
depthlevelNMagnitude Depth Level N Magnitude (m/s) 
depthlevelNDirection Depth Level N Direction (deg) 
 

04Hs M=
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NOTES.   
The Sea and Swell parameters are calculated based on the Sea Swell 
Transition Frequency, which is set in the Advanced Processing page of the 
new Project Wizard. 
Surface Track must be valid for the zero up-crossing parameters (Hmax, 
Tmax, H1/3, T1/3, Hmean, Tmean, H1/10, T1/10, Hmean, Tmean, Hs_Sea and 
Hs_Swell) to be calculated. 
Log 9 format is not valid for Horizontal ADCP waves applications since 
there is no surface track for HADCP. 

 

Example: 
    1,07,06,25,18,43,24,39,1.03,9.40,283.0,7.29,294.0,0.80,9.44,283.0,0.65, 
10388.000,1.73,6.75,1.11,7.26, 0.72,5.80,1.40,7.33,280.0,43,0.092, 13,0.092, 
16,0.075, 11,0.043,  
1,0.008,277,0.035,225,0.061,202,0.083,195,0.112,202,0.138,203,0.140,200,0.115,19
6,0.112,197,0.101,192,0.089,194,0.085,188,0.075,172,0.145, 91,0.308, 49,0.427, 
57,0.229, 74,0.113,108,0.121,123,0.101,122,0.141,127,0.236,163,0.359,150,-
32768.000,-32768,-32768.000,-32768,-32768.000,-32768,-32768.000,-32768,-
32768.000,-32768,-32768.000,-32768,-32768.000,-32768,-32768.000,-32768,-
32768.000,-32768,-32768.000,-32768,0.491,303,0.272,347,0.255, 22,0.253, 
41,0.069, 73,0.172,211 
    2,07,06,25,19,03,24,39,0.93,5.90,286.0,5.94,286.0,0.75,9.44,286.0,0.56, 
10392.000,1.67,8.25,1.08,7.24,0.71,5.75,1.36,7.55,287.0,43,0.078, 19,0.059, 
15,0.034,348,0.035,265,0.028,280,0.012,301,0.012,235,0.060,201,0.110,204,0.142,2
05,0.142,204,0.146,205,0.126,203,0.114,199,0.099,198,0.079,193,0.070,173,0.152, 
92,0.295, 49,0.340, 52,0.195, 
75,0.120,134,0.120,151,0.121,158,0.113,171,0.244,132,1.799,148,-32768.000,-
32768,-32768.000,-32768,-32768.000,-32768,-32768.000,-32768,-32768.000,-32768,-
32768.000,-32768,-32768.000,-32768,-32768.000,-32768,-32768.000,-32768,-
32768.000,-32768,0.275,333,0.296,348,0.200, 16,0.155, 38,0.051,113,0.219,201 
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4.3.11 Format 10 
Table 11: Waves Parameters Log: Format 10 
String Description 

Burst# Burst number 

YY,MM,DD,HH,mm,ss,cc Date and time field.  Leading zeros are always included to maintain fixed length. 
YY = 2 fixed digits for year, MM= 2 fixed digits for month, and DD= 2 fixed digits 
for day. 
HH = 2 fixed digits of hours, mm = 2 fixed digits of minutes, ss = 2 fixed digits of 
seconds, and cc = 2 fixed digits of 1/100th seconds. 

Hs Significant Wave Height (meters)  

Tp Peak Wave Period (seconds) - period associated with the largest peak in the 
power spectrum 

Dp Peak Wave Direction (degrees) - peak direction at the peak period. 

Depth Water level (from pressure sensor) (millimeters) 

H1/10 H1/10 (10% highest waves) = 1.27 * Hs 

Tmean 
Mean Period (seconds)  

Dmean Mean Peak Wave Direction (degrees) 

Hs[0] Height for frequency band 0 (meters)  

Dp[0] Peak Wave Direction (degrees) for frequency band 0 - peak direction at the 
peak period. 

↓  
Hs[6] Height for frequency band 7 (meters)  

Dp[6] Peak Wave Direction (degrees) for frequency band 7 - peak direction at the 
peak period. 

#bins Number of bins 

depthlevel1Magnitude Depth Level 1 Magnitude (m/s) 

depthlevel1Direction Depth Level 1 Direction (deg) 
↓  
depthlevelNMagnitude Depth Level N Magnitude (m/s) 

depthlevelNDirection Depth Level N Direction (deg) 
 

 

NOTE.  Updated with each burst of waves data.  ASCII text, comma 
delimited line for each burst of data.  Format 10 is like Format 8 except it 
also includes Hs and Dp results in seven frequency bands (0 to 6).   
The seven bands reported are: [0] Longer than 8 seconds, [1] 7 to 8 
seconds, [2] 6 to 7 seconds, [3] 5-6 seconds, [4] 4-5 seconds, [5] 3-4 
seconds, [6] Shorter than 3 seconds. 

 

Example: 
10,01,08,22,14,19,00,18,0.82,8.20,280.0,18553.000,1.04,5.90,260.0,0.36,225,0.21,257,0.34,276,0.26,262,0.24,27
9,0.18,152,0.20,338,43,0.043, 24,0.034,  8,0.035,348,0.037,338,0.019,344,0.015, 
42,0.020,101,0.036,118,0.058,128,0.075,134,0.081,135,0.080,141,0.082,140,0.065,145,0.058,150,0.056,162,0.053,
177,0.050,171,0.054,176,0.060,165,0.066,156,0.087,145,0.097,140,0.150, 95,0.180, 22,0.484, 29,0.343, 
57,0.131, 71,0.179, 86,0.158, 90,0.120, 91,0.094, 95,0.073, 
99,0.068,119,0.070,101,0.064,109,0.067,118,0.080,117,0.102,100,0.106, 95,0.120, 82,0.134, 81,0.067, 39 
   
11,01,08,22,14,49,00,18,0.85,8.20,263.0,18424.000,1.08,6.00,260.0,0.37,263,0.20,280,0.32,288,0.30,293,0.27,20
0,0.16,168,0.16,189,43,0.072, 41,0.057, 28,0.051,  
8,0.040,340,0.035,321,0.030,323,0.013,351,0.012,185,0.046,173,0.075,159,0.087,153,0.087,149,0.076,154,0.070,1
55,0.065,164,0.059,176,0.052,193,0.057,205,0.060,195,0.071,177,0.085,167,0.100,158,0.114,143,0.143, 82,0.229, 
13,0.539, 38,0.146, 65,0.153, 98,0.175,103,0.148, 97,0.116, 95,0.098, 95,0.073, 99,0.056,106,0.049,102,0.059, 
89,0.083, 94,0.101,104,0.116,100,0.136, 90,0.102, 88,0.095, 62,0.204, 18 

04Hs M=
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4.3.12 Format 11 
Table 12: Waves Parameters Log: Format 11 
String Description 

Burst# Burst number 

YY,MM,DD,HH,mm,ss,cc Date and time field.  Leading zeros are always included to maintain fixed length. 
YY = 2 fixed digits for year, MM= 2 fixed digits for month, and DD= 2 fixed digits 
for day. 
HH = 2 fixed digits of hours, mm = 2 fixed digits of minutes, ss = 2 fixed digits of 
seconds, and cc = 2 fixed digits of 1/100th seconds. 

Hs Significant Wave Height (meters)  

Tp Peak Wave Period (seconds) - period associated with the largest peak in the 
power spectrum 

Dp Peak Wave Direction (degrees) - peak direction at the peak period. 

Depth Water level (from pressure sensor) (millimeters) 

H1/10 H1/10 (10% highest waves) = 1.27 * Hs 

Tmean 

Mean Period (seconds)  

#bins Number of bins 

depthlevel1Magnitude Depth Level 1 Magnitude (m/s) 

depthlevel1Direction Depth Level 1 Direction (deg) 

↓  

depthlevelNMagnitude Depth Level N Magnitude (m/s) 

depthlevelNDirection Depth Level N Direction (deg) 
 

 

NOTE.  Format 11 is updated with each burst of waves data.  Binary 
format for each burst of data.  Format 11 is the same as Format 5 only in 
DHI Water & Environment format. 

 

4.4 Packets Data Definition 
Wave packets data is similar to the TRDI Ensemble data except it is designed to 
reduce the total amount of data output for waves, which must be sampled at 
2Hz.  Wave Packets data has three main data types.  A typical burst of data starts 
with a First Leader, is followed by 2400 Wave Ping Samples, and ends with a 
Last Leader.  The First Leader data type contains information about how the da-
ta was sampled that will be needed later.  The Wave Ping Samples contain orbit-
al velocity data from a few selected depth cells, pressure, and surface track data 
sampled at 2Hz.  The Last Leader contains averaged information that could not 
be determined until the last sample was taken, such as mean water depth.  

FL, s1, s2,…….s2400, LL.  If motion data has been selected, then each of the 
Wave Pings Samples (s1…) will also contain a HPR data type. 

Expect Ensembles As Well: It should be noted that the ADCP Wave Gauge will 
output Ensembles containing averaged current profile data interleaved in the 

04Hs M=
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middle of a burst of Wave Packets.  For example, if you were collecting current 
profiles every 6 minutes and waves for 20 minutes out of every hour you would 
expect to see the following.   

During the first 20 minutes when waves are being sampled, the output will in-
clude Packets as described above with an Ensemble interleaved every six mi-
nutes.  After the 20-minute wave burst the only output will be the ensembles 
every six minutes. 

Packets Data Definition - Every packet has a Header, some data types and a 
checksum. 
Table 13: Header 
Field # bytes Description Value Units 

ID 2 Packets mode ID word 0x7f79  

Checksum offset 2 Offset to checksum   

Spare 1 Spare   

# data types 1 Number of data types   

Offset [256] 2 Offset to each data type   
 

Table 14: First Leader Type 
Field # bytes Description Value Units 

ID 2 First leader ID word 0x0103  

Firmware Version 2 CPU firmware version, rev   

Configuration 2 Bitmap with sys freq, beam geometry   

Nbins 1 Number of depth cells in profile max (128)  

WaveRecPings 2 # Samples per wave burst   

Bin length 2 Depth cell size  cm 

TBP 2 Time between wave samples 50 hund. Sec. 

TBB 2 Time between wave bursts  Sec. 

DistMidBin1 2 Distance to middle of first depth cell  cm 

BinsOut 1 # Depth cells output   

SelectedData 2 Reserved   

DWSBins 16 Bitmap of bins for dir. waves   

VelBins 16 Bitmap of bins for non-dir waves   

StartTime 8 Start of burst 
(Cen,Yr,mo,day,hr,min,sec,sec100) 

  

Burst# 4 Burst number   

Serial# 8 Serial number   

Temp 2 Temperature  deg. C 

Reserved 2 Reserved   
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Table 15: Wave Ping Type 
Field # bytes Description Value Units 

ID 2 First leader ID word 0x0203  

Ping# 2 Sample #   

TimeSinceStart 4 Time since beginning of burst  hund. Sec. 

Pressure 4 Pressure  deca Pa 

Dist2Surf 16 Range to surface for 4 beams (-1 = bad) mm 

Velocity 2*bins 
*4beams 

Beam radial velocity for selected bins 
(–32768=bad) 

 mm/s 

 

Table 16: Last Leader Type 
Field # bytes Description Value Units 

ID 2 First leader ID word 0x0303  

AvgDepth 2 Average Depth  dm 

AvgC 2 Average Speed of Sound  m/s 

AvgTemp 2 Average Temperature  0.01 deg C 

Avg Heading(See Note) 2 Average Heading  0.01 deg 

Std Heading 2 Standard Dev Heading  0.01 deg 

AvgPitch 2 Average Pitch  0.01 deg 

Std Pitch 2 Standard Dev Pitch  0.01 deg 

AvgRoll 2 Average Roll  0.01 deg 

Std Roll 2 Standard Dev Roll  0.01 deg 
 

Table 17: HPR Ping Type (This data will only be saved when 
HDxxx1xxxx is set) 

Field # bytes Description Value Units 

ID 2 First leader ID word 0x0403  

Heading (See Note) 2 Heading  0.01 deg 

Pitch 2 Pitch  0.01 deg 

Roll 2 Roll  0.01 deg 
 

 

NOTE.  This heading is NOT corrected for magnetic variance even though 
the Average Heading in the Last Leader is corrected for magnetic variance. 
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5 ADCP Waves Performance Specification 
System Frequency 1200 kHz 1200 kHz 600 kHz 600 kHz 300 kHz 

Deployment Depth 5 m 10 m 20 m 40 m 80 m 

Bin Size 0.35 m 0.35 m 0.5 m 1.0 m 2.0 m 

Non-Directional Spectrum      

Surface Track Cut-Off Freq (Hz) 0.99 0.99 0.99 0.74 0.54 

Surface Track Cut-Off Period (s) 1.01 1.01 1.01 1.35 1.85 

Surface Track Min Wave Ht (m) 0.10 0.10 0.14 0.29 0.57 

      

Velocity Cut-Off Freq (Hz) 0.60 0.56 0.50 0.38 0.36 

Velocity Cut-Off Period (s) 1.67 1.79 2.00 2.63 2.78 

Velocity Min Wave Ht.  (m) 0.05 0.05 0.05 0.15 0.10 

      

Pressure Cut-Off Freq (Hz) 0.39 0.30 0.23 0.16 0.10 

Pressure Cut-Off Period (s) 2.56 3.33 4.35 6.25 10.00 

Pressure Min Wave Ht (m) 0.03 0.03 0.03 0.05 0.1 

      

Directional Spectrum      

Directional Cut-Off Freq (Hz) 0.58 0.42 0.30 0.21 0.14 

Directional Cut-Off Period (s) 1.72 2.38 3.33 4.76 7.14 

Directional Min Wave Ht. (m) 0.05 0.05 0.05 0.15 0.10 

      
 

Assumes Hs of 2 meters at 10-second peak period, and a sample rate of 2 Hz: 
Exact cut-off frequency will vary with environmental conditions. 
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6 Software History 
Version 3.07 (May10 - PRESENT) 

• Added enhancement where upper cutoff frequency is being automatically 
calculated, no need for user input 

• Now calculate all zero up-crossing parameters (Hmax, Tmax, H-1/3, T-
1/3, Hmean, Tmean, H-1/10, T-1/10, Hmean, Tmean, Hs-Sea and Hs-
Swell) for valid surfacetrack in a waveburst. Output is via log 9 only. 

• Improved speed to reprocess a data set 

• Improved robustness of data collection in real-time 

• Made improvements to Magnetic Variation corrections 

• Created ability to mask certain beams when calculating currents with 
HADCPs 

• Changed/raised default lower frequency threshold to 0.03 to avoid 
processing erroneous data 

• Corrected time slip when non-waves packets data was processed for ho-
rizontal waves 

• Now able to handle files with excessive corrupted data (bad checksum) 

• Removed erroneous error message during log data output 

• Improved the auto-start routine and disabled non-critical user prompts 
during auto-start 

• Enabled Wave Parameters log output during real-time data collection. 
Version 3.06 (Jan09 – May10) 

• Added capability for moving of project data and/or project file 

• Allow calculation of both sea and swell in the one instance of the appli-
cation. 

• Fixed Submergence/Depth/Altitude for Horizontal ADCP in the Wizard 
Summary page. 

• Fixed a case where if the first waves burst had a smaller than usual num-
ber of array bins, bursts with additional array bins would not process. 

• Fixed WavesMon averaging and transforming Beam Coordinate for WH 
ADCP Ensembles to Earth Ensemble. 

• Fixed FFT Bin averaging to no longer include the 1st term (the DC off-
set). 
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• Added ability to calculate Hmax via Zero-Crossing analysis of Surface 
Track. 

• Fixed negative depth and bad Hs, Tp, Dp when using Surface Track for 
depth. 

• Fixed a Bin Indexing error in Full-Ensemble FindSurface that was yield-
ing an under-call of depth by one bin size. 

Version 3.05 (January 2009 to present) 

• Added Vista compatibility  

• Fixed EB not updating EH during re-processing  

• Fixed velocities and Directions marked BAD are getting MagVar correc-
tions applied 

• Fixed export Fourier Coefficients for UVW Processing  

• Fixed UVW Processing yielding inconsistent Dp  

• Fixed problem parsing customer Data 

• Fixed problem where WavesMon does not sequentially number current 
profile ensemble numbers when it creates them from a HADCP.  

• Fixed problem where WavesMon is not averaging all data types when 
averaging currents from a HADCP.  

• Fixed problem when transforming Currents from HADCP, make Wa-
vesMon use the same transformations as are done in WH Horizontal 
ADCPs.  

• Fixed EX not set when WavesMon outputs current profiles from 
HADCP.  

• Fixed HADCP Averaged Current Output is not averaged.  

• Fixed WP not set for HADCP average current output. 
Version 3.04 (March 2008 to January 2009) 

• Added Squelching of directional noise floor for Processing using Hori-
zontal Wave Gages  

• Fixed processing slow-downs when processing waves where Wave Gage 
is in deep water (deeper than 50m)  

• When saving Wave Spectra Text files the Log files were limited to 1 
burst.  This has been fixed.  

• Updated default directional range in Time Series from 5-360 degrees to 
0-360 degrees. 
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• Added support to allow setting a fixed heading.  

• Added support to allow overriding Magnetic Variation  

• Fixed an algorithmic error in accumulation of Spectra  

• Changed "HMax" to "H1/10" in the Log Format Output legends to accurate-
ly reflect that we are outputting H1/10 not HMax.  

• Fixed hang-up when loading a project with a large number of files.  
Version 3.03 (Dec-2007 – Mar-2008) 

• Fixed setup problem when processing 40 min bursts for Horizontal 
ADCPs  

• Fixed setup of number of bins and bin sizes for different Horizontal se-
tup types 

• Added WB0-command for all Horizontal setup types  

• Changed default processing bins for Horizontal systems  
Version 3.02 (Jun-2007 – Dec-2007) 

• Initial Release  
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NOTES 
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